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Preface
The LabSolutions IR software is one component of the LabSolutions software package and is used with the 
Shimadzu's Fourier Transform Infrared Spectrophotometer series to control the instrument and perform data 
analysis.
The operation manual for the LabSolutions IR software comprises four volumes including this manual. This quick 
guide briefly introduces the LabSolutions IR software from startup through to initial operation.
For more details on usage, refer to the corresponding operation manual.

Installation and ••
Maintenance Manual

This manual explains software installation, troubleshooting, and environment 
settings.

Management Manual•• This manual explains how to use the management function and validation 
software.

Basic Operation ••
Manual

This manual explains specifically how to perform basic operations using the 
software.

Quick Guide•• This quick guide briefly introduces software startup through to initial operation.

Quick Guide Notation

 @@@@@
Emphasizes additional information that is provided to ensure the proper use of 
this product.

 ***** Indicates information provided to improve product performance.

 ^^ Indicates the location of related reference information.

1.Creating a Calibration Curve

Software 

Quantitation

Photometric 

Postrun / View

Manipulation

Search

Library Creation and Editing

Report Template Creation

Easy Macros

2.Determining Quantities in Unknown Samples

NOTICES
If the user or usage location changes, ensure that this Instruction Manual is always kept together with the ••
product.

Information in this manual is subject to change without notice and does not represent a commitment on ••
the part of the vendor.

Any errors or omissions which may have occurred in this manual despite the utmost care taken in its ••
production will be corrected as soon as possible, although not necessarily immediately after detection.

All rights are reserved, including those to reproduce this manual or parts thereof in any form without ••
permission in writing from Shimadzu Corporation.

The contents of the hard disk of the personal computer may be lost as the result of an unforeseen accident. ••
Always create a backup to protect critical data from such accidents.

 Replacement parts for this product will be available for a period of seven (7) years after the product is ••
discontinued. Thereafter, such parts may cease to be available. 
Note, however, that the availability of parts not manufactured by Shimadzu shall be determined by the 
relevant manufacturers.

O	riginal version is approved in English.••

© 2012 Shimazdzu Corporation. All rights reserved.
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Software 
S

oftw
are 

Shimadzu offers the following three software versions in the LabSolutions IR series.
This quick guide uses the file management version of LabSolutions IR to explain operation.

LabSolutions DB IR LabSolutions CS IR

Data backup

Startup method

Standalone / network

Project management

Authorized group management

User management

CLASS-Agent database

LabSolutions database

Transferring LabSolutions IR data between 
PCs

Data management method

Data references

Edition Database edition

Measured data files are saved and managed in the LabSolutions database.
The existence of data files cannot be checked using Windows Explorer.

The software references files in the database.

Loading via import
(Data can be either copied to a local destination using the data file export function or downloaded from the database manager.)

Unavailable
(The contents of the CLASS-Agent database can be transferred to the LabSolutions database.)

Available

Performed for each database.

Available

LabSolutions icon

Available

Available
(The database resides on a local PC)

Client server edition

Available
(The database resides on a server or local PC)

File management edition

Measured data files are saved and managed in folders on the PC.
The existence of data files can be checked using Windows Explorer.

The software references files in folders or drives on the PC.

Transfer of files

Unavailable

Available (Option)

Available

Available

Unavailable

Either can be used.

Performed on a file-by-file basis using Windows Explorer.

LabSolutions IR icon, LabSolutions icon

LabSolutions IR

Only the standalone configuration can be used.

Either can be used.
(LabSolutions IR data can be viewed using the database 
manager on a PC set up for viewing purposes. Note that 

LabSolutions IR must be installed on the PC used  
for viewing.)
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Initialization22
Check that power is supplied to the FTIR.111
Select [Initialize].222
A green rectangle (  ) is displayed in the status monitor.

"Initialization is succeded." is displayed in the log.

Enter a Filename  44 and Sample Information
Enter a filename.111
Enter the sample information.222

入力Input2

クリックClick3 

Spectrum 

クリックDouble-click1

Startup11

Postrun77
Perform operations including printing, searching, and 
manipulation with respect to spectra.

See "Postrun/View" on pages 12 to 13^^

Perform Background 55 Measurment 

Set the background sample.111
Click [BKG Scan].222
A background spectrum is displayed.

クリックClick4 S
pectrum

 

This section explains the general spectrum program procedure for samples.

Set Scan Parameters33
Click the [Data] tab.111
Set scan parameters such as the number of 222
scans and resolution.	

Measure the Sample66
Click [Measurement].111
Set the sample.222
Click 333  .
A spectrum of the sample is displayed.	
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Continues from step 3  
in "2. Determining Quantities in Unknown Samples" 
on page 9

クリック

クリック

④ダブルクリック

This section explains how to create a calibration curve that is required for quantitation of unknown samples.
Calibration curve creation requires a standard sample spectrum measured using spectrum program in absorbance mode 
to be saved in advance.

クリックClick3
選ぶSelect5

Click8

クリックClick4

Click7

波数を入力Enter a 
wavenumber

If a saved calibration curve 
already exists, proceed to 

step 2  in "2. Determining 
Quantities in Unknown 
Samples" on page 8

入力

Quantitation 1.Creating a Calibration Curve

クリックDouble-click1

Input1

設定Configure settings9

Create a Standard Sample 33 Table

Click [Import].111
The [Import Spectrum] window is displayed.

Select the standard sample spectrum and click 222
[Import].

Click [Close] to close the [Import Spectrum] 333
window.

Enter the concentration into each row.444

Startup11

Set Scan Parameters66
Click the [Scan parameters] tab.111
Click [Settings].222
The [Instrument Parameters] window is displayed.

Set scan parameters such as the number of scans  333
and resolution.

Click [OK].444

Set Calibration Curve Parameters44
Click the [Calibration Curve] tab.111
Click [Settings].222
The [Edit calibration curve] window is displayed.

Set the calibration curve parameters.333
The input procedure is shown to the right.

Click [OK].444

Save the Calibration Curve77
Click [Save Calibration Curve].111
Enter a filename and click [Save].222

1.C
reating a C

alibration C
urve

6

Q
uantitation 

Configure 
settings

Configure 
settings

2

入力Input2 

クリックClick3 クリックClick4 

Create a Calibration Curve55
Click [Calibration].111
A calibration curve is displayed.

Initialization22
Check that power is supplied to the FTIR.111
Select [Initialize]. 222
"Initialization is succeded." is displayed in the log.
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クリック

This section explains quantitation of unknown samples using calibration curves and how to calculate and assess the 
measurement results of unknown samples. A calibration curve must be measured and saved in advance.

Proceed from here when continuing from step 7  
in "1. Creating a Calibration Curve" on page 7

Click5

選ぶSelect2 クリックClick1

クリックClick4

式を入力Enter an equation
3

Quantitation 2. Determining Quantities in Unknown Samples

Perform Background 55 Measurement

Set the background sample.111
Click 222  .
A background spectrum is displayed.

Perform Quantitative Measurement 66 of the Unknown Sample

Set the unknown sample.111
Click 222  .
A spectrum is displayed. 

When measurement is complete, concentrations are  

displayed in the unknown sample table.

Load a Calibration Curve22
Click [Load Calibration Curve].111
The [Open] dialog box is displayed.

Enter the filename and click [Open].222
The calibration curve is displayed.	

Startup11
See "Quantitation 1. Creating a ^^

Calibration Curve" on page 6

Prepare the File33
Click 111  .
file specification dialog box is displayed.

Enter the name of the quantitative data file and 222
click [OK].

Post-processing77
Click the [Equation] tab.111
Click [Edit].222
The [Equation setting] window is displayed. 

Set an equation.333
The procedure is shown below.

Rcalculation88
Click [Calculation].111
The result is updated to the unknown sample table.

Prepare the Unknown Sample 44 Table

Click [Insert Line].111
Enter the spectrum name (mandatory) and 222
sample information.

Selecting multiple sample cells and clicking [Edit All] 

allows collective input in the [batch sample information 

input] window.

2. D
eterm

ining Q
uantities in U

nknow
n S

am
ples

Q
uantitation
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Measure the Sample88
Set the sample.111
Click 222  .
When measurement is complete, the photometric results 

are displayed in the sample table.

Prepare the Sample Table66
Click [Insert Line].111
Enter the spectrum name (mandatory) and sample 222
information.

Selecting multiple sample cells and clicking [Edit All] allows 

collective input in the [batch sample information input] 

window.

Perform Background 77 Measurement

Set the background sample.111
Click 222  .
background spectrum is displayed.

Prepare the File55
Click 111  .
A file specification dialog box is displayed.

Enter a name for the photometric data file and click 222
[OK].

　 　 　 　111

選ぶ

クリック

クリック

Photometric 

Startup11

Initialization22
Check that power is supplied to the FTIR.111
Select [Initialize].222
"Initialization is succeeded." is displayed in the log.

Set an Equation33
Click the [Equation] tab.111
Click [Edit].222
The [Equation setting] window is displayed.

Set an equation.333
The input procedure is shown below.

入力Input2 

クリックClick3 

Select2

Click5

Click1

クリックClick4

Set Scan Parameters44
Click the [Scan parameters] tab.111
Click [Settings].222
The [Instrument Parameters] window is displayed.

Set scan parameters such as the number of scans 333
and resolution.

Click [OK].444

クリックClick4 
クリックDouble-click1

波数を入力Enter a 
wavenumber

3

P
hotom

etric 

This section explains how to scan intensity (such as absorbance and transmittance) as well as peak height and area at specified positions 
(wave numbers and wavelengths) on a spectrum. A variety of calculations can be performed using the scanned values.
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Search / Edit LibraryṲṲ
See "Search" on pages 16 and 17 ^^

See "Library Creation and Editing" on pages 18 and 19

Zooming Spectrum ṲṲ
Drag on the graph window to create a 111
quadrilateral.

Click the desired position to magnify.222
The display is magnified.

*****
The spectrum can be zoomed in or out automatically by ••
clicking [Autoscale] on the right-click menu.

 Return the spectrum to its original size by clicking  ••
[Full view] on the right-click menu. 

ManipulationṲṲ
See "Manipulation" on pages 14 and 15^^

　　　　

ChemometricsṲṲ
Refer to "Chapter 10 Chemometric Quantitation" in LabSolutions ^^

IR INSTRUCTION MANUAL (Basic Operation Guide)

When Performing Postrun from Measurement ProgramsṲṲ
@@@@@
The measurement programs that allow postrun are ••
spectrum program, time course program, and mapping 
program.

[Chemometric] and [Edit Library] cannot be selected in ••
the windows of each measurement program.クリックClick

Drag and drop the red line onto the loading position.333
The coordinate values of the point are displayed in the point 

pick table.

Click to confirm.444

Peak PickṲṲ
Click the [Peak Pick Table] tab.111
Click 222  at the lower left and select [Auto Cursor].
A red line is displayed in the graph window.

Drag and drop the red line onto the loading position.333
Peak point data is displayed in the peak table.

Click to confirm.444

Postrun / View

クリックDouble-click1

Startup11

Print / Print PreviewṲṲ
Data can be printed using the specified report 
template.

*****
When printing with a report template,  ••
click [Print Preference] on the [Tool] menu.

When printing with a different report template,  ••
click [Print with Template] on the [File] menu.

View Print / View Print PreviewṲṲ
Select the information for printing in the [Viewprint 
Settings] window.

Postrun  22
Display data for postrun.

クリック

入力Input2 

Click3 クリックClick4 

P
ostrun / V

iew

 JoiningṲṲ
Click [Join All] on the [Window] menu.111
All currently displayed data is shown in an overlaid state.

This section explains the functions for displaying data, peak pick, zooming data on screen,and overlaying data on the vertical axis.

Point PickṲṲ
Click the [Point Pick Table] tab.111
Click 222  at the lower left and select [Cursor].
A red line is displayed in the graph window.
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Difference SpectrumṲṲ
Select the target spectrum from the tree view.111
Click [Send to Source] on the right-click menu.222
Select the reference spectrum from the tree 333
view.

Click [Send to Reference] on the right-click 444
menu.

The selected spectra appear overlaid.

Select [Subtract 2 data] under [Method].555
Click [Calc].666
The result of calculation is displayed.

Click [OK].777
The result of calculation of the spectra is saved.

This section explains how to perform manipulation for peak pick and difference spectra.
For details on other manipulation, refer to "Chapter 8 Manipulation" in LabSolutions IR INSTRUCTION MANUAL (Basic Operation Guide).^^

Manipulation

差スペクトルを求める場合はここをク
リック

差スペクトルを求める場合はここをク
リック

Click here to calculate 
 a difference spectrum

Manipulation22
Peak PickṲṲ

Set the peak pick parameters on [Parameter].111
Click [Calc].222
The result of peak pick is displayed.

Preparation11
Display the spectrum required for manipulation in 111
the display window for the relevant measurement 
program or postrun window.

*****
The measurement programs that allow manipulation 

are spectrum program, time course program, and 

mapping program.

Display the relevant 222 manipulation window.

ピーク検出を
する場合はここをクリック

ピーク検出を
する場合はここをクリック

Click here  
to detect peaks

M
anipulation
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Search

Preparation11
Display the spectrum to be searched 111
in the display window for the relevant 
measurement program or postrun window.

*****
The measurement programs that allow searching 
are spectrum program, time course program, and 
mapping program.

選ぶSelect2

クリックClick 1

Display the search window.222

Close77
Click [Close].111
Return to the search window.

Click [View].222
Search exits.

SubtractionṲṲ
Click [Difference Factor] to calculate the difference 
spectrum of the search target spectrum and the 
spectrum selected in the hit list.

Adjust the factor.111
Click [Done].222
The difference spectrum is saved to the spectrum.

*****
Return to the original search results display by 

clicking [Join] or [Difference Factor] again.

Select a Library22
Click the [General] tab and click [Add].111
The [Select Libraries] window is displayed.

Select a file and click [Open].222
The library is added to the list.

Select an Algorithm33
Click the [Spectrum] tab.111
Select [DiffDerive] or [CorrDerive] from the 222
[Algorithm] list.

Execute the Search44
Click [Spectrum Search].111
The search results are displayed.

Post-Search Processing55
JoinṲṲ
Click [Join] to display the search target spectrum 
overlaid with the spectrum selected in the hit list.

Saving66
Click [Fix search result].111
The search results are saved.

S
earch

This section explains how to search for the spectrum.
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Display the [Edit Library] window.222

This section explains how to insert spectra to a library. This allows searching of spectra inserted in the library.

選ぶSelect2

Library Creation and Editing

Preparation22
Display the spectrum to be inserted 111
to a library.

Adding a SpectrumṲṲ
Select a spectrum from the tree view.111
Click [Insert into Library] on the right-click menu.222
A message is displayed.

Click [Yes].333
The selected spectrum is added to the spectrum list.

Deleting a SpectrumṲṲ
Select the spectrum for deletion in the spectrum list.111
Click [Delete] on the right-click menu.222
A message is displayed.

Click [Yes].333
The selected spectrum is deleted from the spectrum list.

Editing a SpectrumṲṲ
Double-click on the spectrum for editing in the spectrum list.111
A message is displayed.

Click [Yes].222
The [Edit Spectrum Information] window is displayed.

Click [OK] after editing is complete.333
The spectrum is updated in the spectrum list.

Edit the Library44
@@@@@
Commercial libraries cannot be edited.

Startup11
See "Postrun / View" on page 12^^  

クリックClick 1

Library C
reation and E

diting

Create a Library33
Select [New].111
The [Create User Library] window is displayed.

Enter information for the library and click [OK].222
A new edit library window is displayed.
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クリックClick3

Print55
Select [Print Preview].111
The print preview window is displayed.

Select [Print]  in the print preview window.222
The [Print] window is displayed.

Set each item and click [OK].333
*****
Select [Print] in the edit print format window when 

printing without checking the output using print 

preview.

Report Template Creation

 Check Properties33
Click on an item in the report layout window to 
display information on the item in the properties 
window.

Display the edit print format window.222
Prepare Data11
Display the data for printing in the relevant 111
measurement program window or postrun 
window.

Select an Item22
Drag and drop the selected item  111
into the report window.

Move the cursor to adjust the size 222
 and then click.

Adjust the overall layout.333
*****
Items in the report layout window can be moved by ••
dragging them. 

Items can be enlarged or reduced by dragging a ••
point on the frame that contains them in the report 
layout window.

Drag and drop

Select

クリックClick

R
eport Tem

plate C
reation

Select the item 
for allocation

Select the item 
  for allocation1

割り当てるファイルを選ぶSelect the file for allocation
2

クリックClick 4

Registration44
Printing can be made easier by registering created 
report templates in advance.

Click [Print Preferences] on the [Tool] menu.111
The [Print Preference] window is displayed.

Register the report template.222
The registration procedure is shown to the right.

This section explains how to arrange LabSolutions IR data and information in order to create a template for printing.
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Registration55
Easy macros can be registered to the following location.

LauncherṲṲ

Click launcher's 111  icon.
The [Configuration] window is displayed.

Click the [Macro] tab and click [Add].222
The [Edit Macro] window is displayed.

Enter a title, comment, and filename and click [OK].333
The macro is added to the list.

Click [OK].444
The macro is allocated to a launcher button.

Postrun Main ToolbarṲṲ
Start the postrun program.111

See "Postrun / View" on page 12^^

Click 222  under [Easy Macro] and select [Add Macros].
The [Macro List] window is displayed.

Click [Add].333
The [Macro] window is displayed.

Enter a macro name and filename and click [OK].444
The macro is added to the macro list.

Click [OK].555
The macro is allocated to a registered macro button on the main toolbar. 

This section explains how to arrange a sequence of operations in order beginning with LabSolutions IR startup and register the sequence 
as a macro program.

Execution66
The following procedure explains execution  
from the launcher.

Click the launcher icon.111
The [Macro Execute] window is displayed.

Click [run].222

Easy Macros

クリックDouble-click1
クリックClick4 

Startup11

Select Macro Items22
Drag and drop command items into the edit macro 
sequence window in the order of execution.

@@@@@

Always start the sequence with [Program Start] and end 

the sequence with [Program End].

*****

 is displayed at the insertion position after a second 
item is added.

Drag and drop

入力Input2 

Saving44
Select [Save as].111
The [Save As] dialog box is displayed.

Enter a filename and click [Save].222

Select

E
asy M

acros

Macro Sequence Check33
Click [Check].111
The [Information] window is displayed.

Click [OK].222

クリックClick3 
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